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Revision History 

This manual’s title page contains the following identifying information: 

 Version number, which indicates the software version. 

 Print date, which changes each time the document is updated. 
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Table 1 indicates changes made to this document since the last released edition. 

Table 1:  Changes to This Document 

Date Description 
December-2004 New OVPM User's Guide and Tutorial for the 5.0 cross 

platform version, replaces the OVPM Concepts Guide 
and the OVPM Quick Tour. 

March 2006 OVPM version 6.0 
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Overview 

Introduction 

OpenView Performance Manager (OVPM) is a web-based analysis tool that helps you 
evaluate system performance, look at usage trends, and compare performance between 
systems.  Using OVPM you can display any of the following: 

• Graphs such as line, bar or area 

• Forecast graphs 

• Tables for data such as process details 

• Baseline graphs 

• Dynamic graphs in Java format that allow you to turn off display of individual 
metrics or hover over a point on a graph and see the values displayed 

As part of OVPM you can also use the OVPM Planner. The Planner function uses time-
series based statistical forecasting techniques to predict the service demands of your 
users. It helps you make more reliable decisions on when to acquire additional resources 
or adjust system load to meet changing demands. 
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Introduction 

With OVPM, you can isolate interesting data and identify abnormal patterns. For 
example, the CPU Baseline graph shows your system’s averages over time. 

 

figure 1 CPU Baseline 
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Overview 

You can also view many types of graphs, such as area, bar, line and table. 

figure 2 Graph Types 

 

In addition, with the Drill-down tool, you can easily access more detailed information for 
a more in-depth analysis. 
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Introduction 

The OVPM Planner provides the ability to generate a variety of forecast graphs. The 
main purpose of these graphs is to gain some understanding of how a particular 
performance metric, such as CPU Utilization, might behave in the future.  You can also 
import specially formatted text files (also called Business Unit flat files) into OVPM, and 
create forecast graphs to view the impact of the business workload on your systems. 

For more information about the Planner feature, refer to the OpenView Performance 
Planner manual. 

 

figure 3 Planner Graphs for Forecasting 
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Overview 

How OVPM Works 

OVPM does not store performance data. Instead it uses data collection agents as data 
sources. Agents collect data from computer systems, summarize it and make it available 
for analysis and display. All systems with the same data source have the same set of 
predefined graphs provided in OVPM.  

OVPM displays performance information only for systems with any of these agents or 
data collection software installed: 

• OpenView Reporter (OVR) 

• OpenView Performance Agent (OVPA) 

• OpenView Internet Services (OVIS) 

• OpenView Operations Agent (OVOA) 

• Various OpenView Smart Plug-ins (SPIs) that supply data to a supported agent 

• Generic Database (Microsoft SQL Server or Oracle) 

• Specially formatted text files (also called business unit files or flat files) 

figure 4 How OVPM Works 

 

When you request a graph, OVPM retrieves the data necessary to create the graph or 
table from the data source you specified. The data is summarized based on your request, 
then formatted and displayed back to the OVPM Java or Web Forms web display.  

Although OVPM provides many predefined graphs, you can easily create your own 
custom graphs as well.  
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How OVPM Works 
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Getting Started Getting Started 

Accessing OVPM Accessing OVPM 

Once OVPM is installed, you access its home page (OVPM.htm) by URL on the web 
server where OVPM is installed. For example: 
Once OVPM is installed, you access its home page (OVPM.htm) by URL on the web 
server where OVPM is installed. For example: 

http://managementserver:8080/OVPM       http://managementserver:8080/OVPM       

where managementserver is the web server where OVPM is installed, and 8080 is the 
port it is using. 
where managementserver is the web server where OVPM is installed, and 8080 is the 
port it is using. 
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Accessing OVPM 

Before pressing the Web Forms interface button, you should enter your logon and 
password if appropriate. (If the OVPM Administrator has not configured customers for 
your installation, then the logon and password fields may be blank.)  

The logon is entered into the Java interface by pressing the logon button on the Java 
interface main screen. 

If no systems or graphs are present after logging in, you may need to get a customer 
name and password from your administrator. 

There are various login modes that restrict your rights to view systems, create and 
design graph templates, access the Design tab, and save the templates you design.  
Contact your OVPM Administrator for more details. 

The Web Forms interface also allows you to select a "Style". The style can affect the look 
and feel and it can affect which fields are presented in the web forms. For example:    

Style Description  

Standard The Standard style presents a tabbed look and feel and presents the most commonly used 
fields.  

Internet 
Services 

Use this style to view your OV Internet Service (OVIS) information such as the services, 
probe types etc. when you have OVPM installed on the same system as OVPM.  OVIS must 
be installed on the same system as OVPM server for this style to appear in the list. 

MMC The MMC style presents the Microsoft Management Console look and feel and is used to 
view your OpenView Operations for Windows information when you have OVO/Windows 
installed on the same system as OVPM.  
OVO for Windows must be installed on the same system as OVPM server for this style to be 
present. 

Plain The Plain style presents the same fields as the Standard style but with a much plainer look 
and feel than the tabbed style.  

Print The Print style is the same as the Standard style except that it forces all graph lines to be 
drawn double wide to be more visible on a printer.  

Reporter The Reporter style is used to view your OpenView Reporter information. Reporter needs to 
be installed on the same system as the OVPM server, or configured to the Reporter database 
in order for this style to be listed. 

Shifts Adds the Shift fields allowing you to select data by hour of the day, day of the week and to 
exclude holiday dates.  

StartDate This style chooses a date range by setting the starting date/time and the ending date/time 
instead of the usual date range and ending date/time. It also provides for selecting data by 
hour of the day, day of the week and Holidays.  

You can always select a different style by returning to the OVPM Home Page. Note: you 
may have other style selections if you are integrating with other products such as 
OpenView Internet Services. 
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Getting Started 

Two Styles of Interface 

OVPM has two styles of user interface; the Java user interface and the Web Forms 
interface.  

• The Java interface is the most functional and the most interactive. It requires that a 
Java Plug-in which can be installed via the Java Runtime Environment (Java 2 
Standard Edition) be loaded on the system where the web browser is running. Most 
systems will attempt to load this plug-in if it is not found. On some systems, you 
must load the plug-in manually. 

• The Web Forms interface should run in any supported web browser without 
requiring a Java Plug-in. It will load quicker than the Java interface over a slow 
network connection. The Web Forms interface provides most, but not all of the 
functions available in the Java interface. 

 

figure 5 Two OVPM User Interfaces 
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Two Styles of Interface 

The table below gives you a summary of information to use in choosing which interface to 
use. 

Feature Java Interface Web Forms Interface 

Plug-ins Java 1.4.2  or later plug-in is 
required. (see Java Plug-in 
Requirements).  

None required 

Draw 
Predefined 
Graphs 

Yes Yes 

Design Custom 
Graphs 

Yes, simple or complex Yes, simple 

Speed Slower to load, then fast to execute Faster to load, especially on 
slow speed connections. Fast 
to execute. 

Ease of use Provides assistance on choices Less assistance available 

 

 

Bottom Line: Pick the Java interface unless you cannot easily load the Java 
Plug-in or you have a slow speed connection. In this case, choose the Web 
Forms interface. Otherwise, try them both and choose the one you like best. 

 

 

Simple graphs designed in either interface can be drawn by the other. 
However, avoid designing a Java graph and then editing it using Web 
Forms. Your java graph may lose certain features not supported by Web 
Forms. This caution only applies to editing graphs. You can draw graphs 
from either interface once they are designed. 

If you decide you want to use the Java interface exclusively, bypass the home page and 
go directly to the Java interface by selecting the URL 

http://<myserver>:8080/OVPM/PMJavaUI.htm 

where <myserver> is the name of the system where OVPM is installed. Port 8080 is 
the default web server port number which may be different on your installation. 
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Requirements 

Browser Requirements 

You need a web browser for viewing the HTML reports:  

• On HP-UX: Mozilla 1.6, 1.7, Firefox 

• On Solaris: Mozilla 1.4, 1.6, 1.7, Firefox 

• On Linux: Mozilla 1.6, 1.7, Firefox 

• On Windows: Internet Explorer 6.00 or higher  

The web browser does not have to be located on the same system where OVPM is 
installed. You can access OVPM using the Mozilla or Firefox browser on a UNIX system, 
even when OVPM is installed on a Windows system. Multiple users can access the same 
OVPM installation simultaneously. 

Note that you should disable any Pop-Up Blocker software on the OVPM client system 
prior to running OVPM. This is because many of OVPM's displays will appear as pop-ups 
and so would be blocked by this software. 

The computer stores copies of frequently accessed pages in the Web browser's memory 
cache or disk cache. You should set your web browser to check for newer versions of 
stored pages by setting it to "every visit to the page". This setting ensures that the graph 
images will properly update on the system. Otherwise, the browser will cache the graph 
images and not update when you select minor changes and redraw your graph.  

Here are examples of how to do it: 

Internet Explorer 

To specify how often Internet Explorer checks the network for page revisions: 

1 Open IE browser. Select Tools -->Internet Options. Under Temporary Internet Files, 
click the Settings button.  

2 Check the "Every visit to the page" radio button. Click OK.  

Firefox 

To specify how often Firefox checks the network for page revisions (so that "stale" pages 
are not kept in the cache too long): 

1 Open the Firefox browser. Select Tools > Options. 

2 Select Privacy. Under Cache, set the value to zero for "Use up to: 0 KB of disk space 
for the cache". 

3 Click OK. 
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Java Plug-in Requirements 

• Invoking the Java graphs feature will require downloading the J2SE with the Java 
1.4.2 or later Plug-in to the system where the browser is executing. You may be 
prompted to download this the first time your browser invokes this feature.  

 HP-UX: JPI 1.5 and 1.4.x are available. 

• Resources 

o HP: Java on HP-UX. 

 Solaris, Linux, and Windows: Java 1.5 and 1.4.x are available. 

• Resources 

o Sun: Java 1.4.2. 

o Sun: Java 1.4.2 changes. 

o Sun: Java 1.5.0. 

o Sun: Java 1.5.0 Release Notes. 

 

• To check the version of Java Plug-in (or JPI version) you are using: 

⎯ Start (or attempt to start) the OVPM Java User Interface. 

⎯ Enable the Java Console from your browser (Right-click on the Java Icon <show 
icon> and select “Open Console”).  

⎯ The first few lines of the Java Console will list the actual Java Plug-in version 
being used. Or you can click on About. This is often not the version that was 
expected when more than one plug-in is installed.  

⎯ In the Java Control Panel, you can select to download updates. 

• On UNIX systems, it is very important to follow the installation instructions 
provided during the download, and to make sure that the prerequisites are met in 
order to get the J2SE installed properly. Often a system reboot is required in order 
for the plug-in to begin working properly.  

• The first time you draw a Java graph, you should see a message from your browser 
asking whether you want to accept the certificate of the Java applet.  
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⎯ This message is your assurance that the Java applet is a part of this product and 
has not been altered in any way. The message offers options to grant or reject 
("Deny") the applet permissions. Permissions can be granted for the current 
session only ("Grant this session") or always ("Grant always"). It is best if you 
select "Grant always" because, then, the message will not bother you again. If 
you deny permissions, the Java applet will still run, but some interactions with 
your system, such as the graph and table Export feature, will not be available. 

⎯ This message may indicate that the security certificate has expired. Security 
certificates are only marked as valid for a short period of time. This message is 
only a warning that this time has passed. You should ignore this message and 
accept the certificate. 

• If the Java screens are cut off - This may happen if you are using an unsupported 
version of the Java Plug-in. You may also see a wide gray band to the right of the 
display. The solution is to uninstall all versions of the Java Plug-in (use Add/Remove 
Programs from the Control Panel). Then, manually install the Java Plug-in, version 
1.4.2 or later from the web. 
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Getting Data 

Getting Data 

Data is provided to OVPM by performance agents or other software programs that collect 
performance data (metrics). Agents may include OpenView Performance Agent 
(previously known as the MeasureWare Agent and VantagePoint Performance Agent), or 
OpenView Operations Agent version 7 or above. Other data collection programs may 
include OpenView Internet Services, OpenView Reporter and Smart Plug-ins. Agents 
and data collection software are referred to as data sources in OVPM.  

 

Important: Data sources are not included with OVPM. Products such as HP 
OpenView Performance Agent, HP OpenView Reporter, HP OpenView 
Operations and HP OpenView Internet Services must be purchased and 
installed separately.  

OVPM must be able to locate the data sources that are available. Reporter and Internet 
Services must be installed on the same system as OVPM to be recognized automatically. 
If these products are running on a different system, they can be accessed after manually 
configuring OVPM to locate them. See the OVPM Administrator's Guide for details. 
Performance agents can be installed on any system with network access to OVPM. They 
can be located in one of two ways:  

• When Reporter is running, it discovers systems in your network that have 
Performance and/or Operation Agents. If OVPM is configured to use the Reporter 
product, it will automatically have access to this information.  

• If Reporter is not configured, then the System Administrator will have to edit a list of 
systems for each of the different performance agent types. The OVPM 
Administrator's Guide has details on this operation. 

What do you do if you do not have Reporter, or if there are additional systems you want 
to access on your own?  In this case, OVPM can graph data from a supported database or 
OpenView Agent. But you can only access additional system temporarily by using the 
Add button in the OVPM interface.  These added systems will not be visible once you 
leave the current display or refresh the browser display. 

• This version of OVPM supports the following agents:  

⎯ OpenView Operations Agent (OVOA), version 7.20 or later. This agent is 
deployed and managed by OpenView Operations (purchased separately). 

⎯ OpenView Performance Agent (OVPA), previously known as VantagePoint 
Performance Agent or MeasureWare. This agent is purchased and installed 
separately. 

• You can temporarily add a system using either of the OVPM interfaces as described 
below: 

⎯ In the OVPM Java interface, select the Add button in the Display tab to 
temporarily add a system to the Sources tree. OVPM will prompt you to select the 
performance agents to run on this system.    

For Agents Select Data Source 

OVPA 4 Using BBC datacomm CODA  
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For Agents Select Data Source 

OVPA 3 and OVPA 4 Using DCE or 
NCS datacomm 

MWA  

OVOA CODA  

⎯ In the OVPM Web Forms interface, type the name of the system in the Enter 
System Name field. You cannot indicate the type of agents on the system. 

• Only your System Administrator can permanently add systems. Please contact your 
OVPM Administrator when such a need arises. Note that your ability to add systems 
may be restricted by the System Administrator. 

Graph Templates 

Predefined graph templates for each of the performance and operations agents are 
installed with OVPM. Templates for other data sources should be installed with those 
products. In some cases, the graph template files will have to be copied to the OVPM 
system. Look at individual product documentation for details. 

A graph template contains the information needed to get a set of data and display it in a 
graph within the browser. Templates contain the following kinds of information: source 
of the data (that is the agent or data collector), metric or set of metrics, type of graph and 
graph attributes like line color. When you draw a graph, you supply additional 
parameters such as the system name, date range, etc. See a list of predefined graphs in 
the template for each data source. 

User-Defined graph templates: You can create your own user-defined graph templates, 
customized to display the data you need using the OVPM Design function. When you 
save these graph definitions they become usable like any predefined graph. 

Display Mode and Design Mode 

The OVPM interfaces both allow you to work in Display mode, where you use predefined 
graph templates; or in Design mode, where you create your own graphs. 

• Display: Use the Display function to select from predefined or User-defined graphs. 
You can specify additional information concerning the source of the data such as 
which system provides the data, dates and times covered, and type of display to 
generate (Java or HTML). And you can select multiple systems to draw multiple 
graphs or a single comparison graph, depending on the graph design.  

• Design: Use the Design function to create your own graphs. You can open a 
predefined graph and modify it to suit your needs; you must then save your 
modifications into a graph definition of your own. You cannot save a predefined 
graph that you have edited using its original template file and name. Once designed 
and saved, you can utilize user-defined graphs from the Display function in the same 
manner as the predefined graphs. 
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Display Mode for Predefined Graph Templates 

In the Display mode, predefined graph templates have been provided for most types of 
data you want to graph. To use a predefined graph, access OVPM and select whether you 
want to use the Web Forms interface or the Java interface.  

You can practically perform the same functions from either interface so it is just your 
preference. The Java interface provides more interactivity so that the display changes 
based on your selections; the Web Forms interface displays in most browsers and does 
not require a Java Plug-in. The order in which items are selected differs between the two 
interfaces:  

• Using the Java interface Display function, you first select the data source you want 
to use. The graphs available in the right panel will vary depending on the data source 
you have selected. This is to help prevent drawing a graph for which no appropriate 
data source is selected.  

• Using the Web Forms interface Display function, you first select the graph template 
file you want to use. The system names and group names in the web form will then 
be adjusted to match the data sources in your graph template file.  

The rest of the items in the Display function can be selected in any order and are quite 
similar, although not identical between the interfaces. Online help is available that 
explains how to use each interface, complete with examples. 

Design Mode for Creating Custom Graphs 

There can be many reasons to design your own graphs. Perhaps a predefined graph 
exists, but you would like to alter it in some way. Perhaps you need to display data from 
a part of a data source that is not covered by a predefined graph (user-defined metrics 
that are provided by Data Source Integration (DSI) in OV Performance Agent are a good 
example). Or perhaps you would like to see the data in a new and exciting way.  

You can use the Design function to preview a graph or to see data only one time. If you 
want to utilize a graph design again, you should save it to a user-defined graph template. 
You can use saved graphs from the Display function as you would predefined graphs. You 
can draw your graph using different systems, or date ranges, even multiple systems. 

OVPM does not allow you to alter the predefined graphs in any way. You can open them 
in the Design function, make changes, and then save them. But you must save them as a 
user-designed graph and are not allowed to save over the predefined graph templates. If 
you really want to modify a predefined graph, try your modifications in a user graph, and 
then ask your OVPM Administrator to move your graph from user to permanent status.  

The mechanics of using the Design function differ between the Java interface and the 
Web Forms interface, but most of the process is the same. A few advanced features are 
available only in the Java interface and not in the Web Forms interface. These features 
include:  

• Complex graphs: Graphs that draw different metrics from more than one data source. 
This is not the same as drawing the same metric from different systems using the 
same type of data source. Both interfaces support this capability. Complex graphs are 
rarely required. An example might be where you want to show data from Internet 
Services and the OV Performance agent on the same graph. Only the Java interface 
can design and display complex graphs of this type. 
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• Assorted features: Graph description, background color, metric line widths, fill styles 
and color selection can be set using the Java interface but not the Web Forms 
interface. 

• Some features, such as graph annotations (header and trailer) and calculated metrics 
can only be set using a text editor at this time.  

The vast majority of graphs do not depend on these features and can be designed using 
either interface. 

Planner 

The OVPM Planner smoothly integrates into the OVPM interface. You can use the 
Planner to forecast system resource consumption. The Planner uses time-series based 
statistical forecasting techniques to predict the service demands of your users.  

You can use the Planner tab in the OVPM interface to design and execute trending 
models against a single metric.  See the OVPM Planner Guide for more information 
about statistical forecasting and details on how to use the OVPM Planner. 

Expert Mode 

If you log in to OVPM as an expert user, then you will be allowed to view and configure 
advanced features. Examples of advanced features can be seen in additional fields being 
available on the Settings dialog box and the Expert tab being available in the Java 
interface. 

The System Administrator uses the Administrator's Interface to configure users and to 
set or unset the "expert" flag for them. The default logon (blank) will not have the option 
to work in expert mode.   

Expert users will see additional client configuration options in the Settings dialog box 
displayed when they select the Settings button at the bottom of the Java interface or 
select the Settings tab in the Web Forms interface.  In addition, the Expert tab in the 
Java interface Design display will be active for users logged in as experts. 
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Designing Your Graph  

The basic process to create your own custom graph is outlined below. See the following 
chapters on using the OVPM Java interface and the OVPM Web Forms interface for 
detailed steps to creating custom graphs and see the chapter on Graph Examples for 
examples of custom graph creation. 

1 Select a model data source. 

OVPM does not know what metrics are available from each of its data sources. It 
discovers this information by examining a model data source, chosen and used during 
the design process.  

Depending on the data source, you may also need to select a model system. Agent 
data sources MWA and Coda, for example, must know which system to contact when 
opening the data source. The RepSys data source is a special version of the Reporter 
data source. The RepSys data source requires that a system name be specified since 
it will treat the Reporter database as if it were a single system data source. Other 
data sources, such as Internet Services and Reporter (not RepSys), do not require a 
model system.  

2 Enter Metric information. 

Select which metrics you want included in the graph. The Metric Class and Metric 
Names vary depending on the data source selected. You can select display options for 
the metric. Refer to online help for definitions and usage assistance on each feature.  

3 Enter date and general graph display options. 

Specify the date range, ending date and Points Every settings you want to use when 
you preview the graph. These settings are used only when you are in the Design 
function since OVPM reverts to the default settings in the Display function. 

Select other graph features at any time during the design process. You can preview a 
graph, make a change, and then preview it again until you obtain the effects you like.  

4 Save the graph. 

Once satisfied with your graph, you should save it so you can re-use this definition. 
Of course, if this is just a one time investigation and you do not expect to use this 
graph design again, then you can skip this step.   

Note that you should not use consecutive spaces in the graph name; otherwise, 
OVPM will not find the graph. (OVPM will find this graph name "This is my graph", 
but not "This is     my  graph".)  Also graph name should not contain "@@" symbols. 

When you save a graph design, you will need to provide information on how to locate 
this graph design in the future.  

⎯ The Java interface uses a graph Family tree, which consists of Family, Category 
and Name. OVPM requires a graph Family and graph Name; a Family serves as 
a group to organize graphs, and a graph Name uniquely identifies a graph 
definition. Note that you may also use Category to group graphs into different 
categories within the same family. 
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⎯ The Web Forms interface uses graph Template Files, which correspond to 
Family, and Graph Names.  

5 Manage saved graphs 

You can use the Design function to open a graph definition. Opening a graph 
definition deploys it into the design function where it can be manipulated. It does not 
alter the original graph definition in any way. You can open user-defined or 
predefined graph definitions. 

 

Important: Do not edit a graph using the Web Forms interface if it was 
designed using the Java interface. The editing will work, but any graph 
features that are not supported by the Web Forms interface will be lost 
when you save the graph. Similarly, editing a graph that has features not 
supported by the Java interface (annotations, calculated metrics) will 
remove those features when you save the graph and so will not necessarily 
match the original graph definition.  

Graph templates are saved on the OVPM server (not the local system). For 
this reason, the only safe way to edit a predefined graph definition is to 
access the OVPM server and edit using a text editor. Feel free to use the 
predefined graph definitions as a starting point on your own graphs, just be 
aware that they may not work exactly like the original if some features are 
removed in the process. 

If you save a graph using the same graph template file name and graph name, then 
you will replace the original file in the template file. Exception: attempting to replace 
a predefined graph will fail since the graph template name will always begin with 
User and no predefined graph template files should begin with User. 

You can delete user-defined graphs that you have access to, which is determined by 
your logon. Your access to graphs also depends on your access level; ReadOnly and 
DisplayOnly logons cannot delete graphs. Note that you cannot delete any predefined 
system graph. Also once the last graph is deleted from a user graph template file, the 
template file itself will be removed. 

Concepts 

The following are a few general concepts to help you understand drawing graphs. 

Date Range and Points Every Options 

Use the Date Range selection to set how much data goes on the graph (Duration of 7 
days or 1 hour for example). Use the Ending selection to adjust up to where in time the 
graph draws. For example 7 Days Ending April 10, 2002 08:00 will include data 
from April 3, 2002 at 08:00 through and including April 10, 2002 at 07:59. Selecting an 
ending date of Now will take data up to the current date and time. Selecting Last will 
take data up to the date and time when data was last added to the logfile. 
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Use the Points Every selection in conjunction with the Duration from the Date Range 
selection to set how dense the data points are. With duration of 1 day, selecting Points 
Every 1 hour will draw 24 points on the graph (or show 24 rows in a table). Selecting 
Points Every 5 minutes will show 288 points (or 255 in an HTML graph, the maximum 
number of points in HTML).  

Setting Points Every to Auto will automatically pick a value such that approximately 
100 data points will be drawn. (This can vary for different graphs types.) Until you have 
a good reason not to, you should use Auto.  

Setting Points Every to Unsummarized will plot one point for every data point that is 
available from the data source (i.e. you will see all the data from the data source). Be 
careful: you can often get more data than you can handle if you do not set a short 
Duration. Some graphs depend on having summarized data and will produce odd results 
if you draw them unsummarized. Use this feature with care. 

HTML and Java Graphs 

There are two basic types of graphs: HTML graphs are static image files while Java 
graphs are interactive Java applets. Each OVPM interface defaults to drawing graphs 
using the same technology as the interface itself. However, they also have an option that 
allows you to draw an HTML graph from the Java interface and a Java graph from the 
Web Forms interface. 

 

• Choose an HTML graph to show a static graph image that is good for copying and e-
mailing, etc. The HTML graphs display quickly on all supported browsers. If you 
want to draw a large number of graphs at one time (such as drawing a graph for 
every system in a group) then the HTML graph might be the better choice. It 
generates one web page with a graphics file for each graph. Java graphs will generate 
an applet window for each graph. (Ever try to close 100 windows when you are 
through with them?) 

• Choose a Java graph to allow interaction with the graph once it is drawn. Java 
graphs can be resized, examined and prodded in a variety of ways. Java graphs allow 
you to select an area of interest from the graph then zoom in to see it better, or even 
to drill-down and draw another graph or table to show what was happening in the 
timeframe you selected. 

Graph Types 

You can display graphs as an area graph, stacked bar graph, bar graph, line graph pie 
graph or gauge.  

Special graph types include baseline graph showing the average values for a metric and 
forecast graph predicting how the metric may perform in the future. Data can also be 
displayed in XML, Excel, TSV or CSV format.  In addition you can drill down to display 
performance metric data in table format. 
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Graph Display Options (Java Interface Only) 

Graph description, background color, metric line widths, fill styles, table filter and 
highlights and color selection can be set using the Java interface but not the Web Forms 
interface. 

Zoom and Drill Down (Java Graphs Only) 

You can select an area of the graph to zoom in on.  

With the Drill Down function you can select an area on the graph for which you can then 
request more detailed information.  

Export data (Java Graphs and Tables Only) 

You can export the data from a Java Graph or Java Table in a variety of formats (CSV, 
TSV, Excel Spreadsheet, web table, etc.) and save it on your local disk or display it in 
another web page. 

Administrator's Tasks 

The OVPM System Administrator has direct access to the system where OVPM is 
installed, and can perform tasks that cannot be performed using the web browser 
interface. These tasks include:  

• Configuring OVPM to access data sources, systems and graphs.  

• Setting security to control who is allowed to access OVPM.  

• Performing special actions, such as promoting a user-defined graph to read-only 
status to prevent its being modified.  

• Setting the default styles for graphs and tables 

An OVPM Administrator's Guide is available on the system where OVPM is installed 
(\paperdocs\Administrator.pdf).   

In addition an online OVPM Administrator interface is available for the person 
administering the OVPM system to configure customers, users, groups and systems for 
use in OVPM. 

OVPM Predefined Graphs 

OVPM includes predefined templates for more data sources. The following lists some of 
the main graphs provided out-of-the-box in the predefined templates:   

Graph Template File: Agents (Performance History) 

Global Performance Graphs  
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Graph Name Description OVPA OVOA 

Global History Overall system performance summary X X 

CPU Summary Summary of CPU utilization X X 

CPU Utilization Baseline(1) Typical weekly CPU utilization X X 

Global Run Queue Baseline(1) Typical weekly global run queue X X 

Disk Summary Overall disk utilization X X 

Disk Throughput(3) Individual disk activity X X 

Memory Summary Summary of virtual memory activity X X 

Network Summary Overall network activity X   

Individual Networks(3) Individual network interface activity  X X 

Individual CPUs Individual processor utilization X X 

Graph Template File: Agents (Performance History) 

Performance Comparison Graphs 

Graph Name Description OVPA OVOA 

CPU Comparison CPU utilization for multiple systems X X 

CPU Gauges CPU gauges for multiple systems X X 

 

Graph Template File: Agents (Performance History) 

Transactions Graphs 

Graph Name Description OVPA OVOA 

Transaction Health(3) Service level objective percent for 
each transaction 

X   

Transaction History(3) A set of metrics displayed for each 
transaction (best seen in HTML) X   

 

Graph Template File: Agents (Performance History) 

Application Performance Graphs 

Graph Name Description OVPA OVOA 

Application CPU Gauges 
A gauge shows the CPU usage  
for each application. Designed  
for use with 1 system at a time. 

X    

Application History Summary of one application's  
activity  X    
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Graph Template File: Agents (Performance History) 

Process Performance Graphs 

Graph Name Description OVPA OVOA 

Process CPU(3) 
Individual Process CPU Usage  
For best results, select a small Date  
Range (process data can be voluminous). 

X    

 

Graph Template File: Agents (Performance History) 

Configuration Graphs 

Graph Name Description OVPA OVOA 

Disk Space Individual file system space used  X    

System Configuration(4) System and collector configuration 
information. X X 

 

Graph Template File: Agents (Performance History) 

Drill Down Tables 

Graph Name Description OVPA OVOA 

Global Details(2) Table of overall system activity X X 

Application Details Table of activity of all applications X    

Process Details(2)(3) Table of all process activity. X    

Disk Details(2)(3) Individual disk device drill-down  
table - selected metrics X X 

Filesystem Details(2)(3) Individual file systems drill-down 
table - selected metrics X X 

CPU Details(2)(3) Individual processor drill-down  
table -  selected metrics X X 

Network Interface Details(2)(3) Table of activity of all network  
interfaces - selected metrics X X 

Transaction Details(2)(3) Table of activity of all ARM 
transactions - selected metrics X   

Configuration Details(4) OVPA configuration drill-down 
table - selected metrics X   

 

Graph Template File: Agents (Performance History) 
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Forecast Graphs 

Graph Name Description OVPA OVOA 

Application CPU Forecasts 
Draws one graph for each application  
showing future CPU usage  

X    

Global CPU forecast Forecasts future CPU utilization X X 

Multiple Global Forecasts Forecasts eight different metrics for a 
system X X 

Seasonal CPU Forecast 
Forecast future CPU utilization 
Allowing for time dependent patterns 

X X 

Transaction Response 
Forecasts 

Transaction response time, one graph 
for each transaction name X  

 

 

(1) Baseline graphs must read all available data in order to form their baseline measures. This 
may take some time regardless of the amount of time selected in the graph. 

(2) These graphs display unsummarized data, regardless of the user interface settings. Short 
date ranges should be used to avoid extremely long run times and truncated data. 

(3) These graphs retrieve data for all instances of a multi-instance data source. For systems with 
a large number of instances (disks, transactions, processes) short date ranges should be used to 
avoid long run times. 

(4) The OVPA data source logs configuration data infrequently. You may have to select a longer 
daterange or use the Ending last setting in order to display any data. 

 

The following graph templates are available if OpenView Reporter integration has been 
configured. 

Graph Template File: Reporter (graphs for the entire database contents for all systems) 

Graph Name Description 

Top CPU 
Systems Each system shows a single bar, sorted by overall CPU usage 

Top Disk IO Each system shows a single bar, sorted by overall average disk transfer rate 

Top 
Networking Each system shows a single bar, sorted by overall network packet rates 

Application 
Sorter 

CPU utilization for each user-defined application on each system. (This graph 
may take a long time to execute. Select a single system in order to reduce the 
time.) 

ARM 
Transactions 

Application Response Measurement transactions 
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Graph Template File: Reporter (graphs for the entire database contents for all systems) 

Graph Name Description 

Global History Overall system performance summary 

CPU Comparison CPU utilization for multiple systems 

CPU Gauges CPU gauges for multiple systems 

CPU Baseline Typical weekly CPU utilization 

CPU Utilization by Shift System CPU utilization by shift 

Global Performance 
Details Table of overall system activity 

Single System 
Configuration 

Table of system configuration details in Reporter, used for single 
systems. 

 

The following graph templates are available if OpenView Internet Services integration has been 
configured. 

Graph Template File: Internet Services  

Graph Name Description 

Internet Response Time Response Time graph for each probe type 

Snapshot Gauges 3 gauges - Availability, Response, SLO Violations 

Snapshot Five Gauges 5 gauges - Availability, Response, SLO Violations, SetUp Time, 
Throughput 

Snapshot Response Bar graph showing setup and response times 

Snapshot Availability Bar graph showing availability 

Snapshot SLO Violations Pie graph showing probe types with SLO violations 

Availability by Service 
Group 

Bar graph showing availability for each service group 

Availability by Customer Bar graph showing availability for each customer 

Availability by Work Shift Bar graph showing availability for each work shift 

Response by Service Group Bar graph showing response time for each service group 

Response by Customer Bar graph showing response time for each customer 

Response by Work Shift Bar graph showing response time for each work shift 

Service Level by Service 
Group Bar graph showing service level violations for each service group 

Service Level by Customer Bar graph showing service level violations for each customer 

Service Level by Work Shift Bar graph showing service level violations for each work shift 

Trend Availability Typical weekly availability 
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Graph Name Description 

Trend Response Typical weekly response time 

Trend Service Level Typical weekly service level violations 
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Using OVPM – Java Interface 

Drawing Predefined Graphs 

The following example demonstrates how to draw a predefined graph using the Java 
interface.  

1 Access the OVPM Home page and click on the Java Interface button. OVPM 
automatically brings up the Display window (otherwise accessed via the Display tab), 
where you will enter the criteria to draw your graph.  
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figure 6 Java Interface Display Window  

 

 

The Sources field defaults to Individual Systems. Therefore, in the Sources pane you 
will see a list of all individual systems organized into groups. In the Graphs pane you 
will see a list of the graphs that can be drawn for the selected systems. 

2 Expand the tree in the Sources pane by clicking on the + sign and select one or more 
systems. The graphs then change to match the system you choose.   

3 Expand the graph tree and select a graph.  
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OVPM comes with predefined graphs for you to select from.  If you have other HP 
OpenView products installed, such as SPIs, Reporter, or Internet Services, their 
graphs will also be available in OVPM. As you select systems in the Sources pane, 
OVPM displays in the Graphs pane the graphs corresponding to the system(s) you 
selected. 

OVPM does not store data. Instead it retrieves the data needed to create the graph or 
table from the data source you specified. 

4 Use the Duration and Ending fields to select the range of data you want to graph. To 
get more data points on the graph, use shorter time periods. The Points Every field 
controls how much data is summarized into a single data point. 

5 Click on the Draw button to see the resulting graph. 

 

figure 7 Resulting Graph 
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Reporter Graphs 

You would use the following steps to draw a graph for a group of systems using the 
Reporter family of graphs. Although you can use the Reporter graphs for individual 
systems, you should use them only for groups of systems, since the graphs were designed 
to analyze the behavior of multiple systems.  

1 Change the Source drop-down value to System Groups on the Java Display window. 

2 Select a group. 

3 In the Graphs pane, select a graph from the Reporter family of graphs, and draw the 
graph. 

A few reminders:  

• If you do not make any selection in the Sources pane, OVPM will draw a graph for all 
systems in the Sources pane.  

• If you select all systems within a group (by right-clicking on a system group name) 
OVPM will then draw a graph for all systems in that group.  

• If you want to draw a graph for a single system within the Reporter database, follow 
the instructions in Example 1 using a graph from the Selected Systems From 
Reporter family of graphs.  

Logon and Configuration Settings 

You can select the Logon button to logon as a different user. The System Administrator 
manages the user and customer logons.  

You can select the Settings button to configure settings that are local to the client 
browser. These settings will be saved in a Cookie on the client system and accessed 
whenever a request is made to OVPM. (NOTE: Cookies should be enabled in the client 
browser for the settings tab to work as expected. If cookies are disabled, the changes 
made in the settings tab will not be saved). The client setting items allow you to change 
the appearance of OVPM graphs from a different client system. These settings will be for 
that system and not your original system. The client settings apply regardless of the 
OVPM logon (user or customer) being used.  
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If you log in to OVPM as an expert user, then you will see additional fields on the 
Settings screen. The System Administrator uses the Administrator's Interface to 
configure users and to set or unset the "expert" flag for them. The default logon (blank) 
will not have the option to work in expert mode.   
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Designing Graphs 

To create your own graphs, use the Design tab. OVPM, by default, displays the Design - 
General window. 

figure 8 Java Interface Design Window – General Tab 

 

You can design a custom graph starting from an existing graph or create a new graph 
from scratch.   

Note that the Highlight, T-Filter, Planner and Expert tabs are greyed out in the Java UI, 
when you first click on the Design tab.  
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To customize an existing graph, click on the Open button in the General tab window. 
Then select a graph from the list of graph templates displayed in the Open Graph 
window.  

 

You can then make modifications such as change the graph type, add a system name to 
the graph title (add @@[SYSTEM] to the title), add metrics to a graph and edit metrics 
properties.  

Note that after you save your customized graph, you can reuse it just like you would any 
predefined graph.  Also note that sometimes, OVPM will not let you proceed until you 
take some action in a dialog box that seems to have vanished from your display. Press 
ALT-TAB to bring up the dialog box. ALT-TAB allows you to toggle between windows 
and will bring up any window that may seem to have disappeared but is simply hidden 
behind other windows.  

Creating a New Graph Using the Java Interface 

To design a graph from scratch, you will need to use the tabs to the right of the Design 
window (General, Metrics, Sources and Chart are used for most graphs. Highlight and T-
filter are only used for tables and Planner is only used for forecast graphs. A tab will be 
disabled unless the type on the General tab is selected accordingly). Click the New 
button in the General tab window to start creating a new graph. 

First, you will need a source of data to use as a model for your initial graph design. 

Click the Sources tab to select a data source. A Source consists of a Data source and 
Default Selection. An agent is an example of a data source and a system or service is an 
example of a default selection. 
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The Default Selection is used only as a model while you create your graph. It allows 
you to retrieve metrics information and preview the graph.  After completing and saving 
your graph, you will then be able to use it for other systems containing the same data 
source. 

Reporter and Internet Services are data sources that do not require you to select a model 
system when drawing graphs from these databases. Graphs from these sources represent 
data taken from all services or systems in the database. 

 

figure 9 Java Interface Design Window – Sources Tab 

 

Click the Filter button (ellipsis… either one) to access the Data source Selection window. 
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Expand the Systems tree to select the group and the system to use as your model data 
source. OVPM will fill in the Data source and Default Selection fields, as appropriate.  

• If you select a system group, you will need to expand the group, expand a system, and 
then select the data source.  

• If you select Reporter, no default selection is required.  

• If you select IS, no default selection is required, but you can select a service if you 
wish by clicking on the Default Selection filter button.  

 

 

In this instance, the system asmdrfs has three data sources. 

MWA and CODA are data collectors installed on asmdrfs. RepSys is a special version of 
the Reporter data source, internal to OVPM, which allows single system data to be 
drawn from the Reporter database. 

 

Upon selecting this data source, OVPM displays both data source and system in the 
Sources window. 

Now, click the Metrics tab.  
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figure 10 Java Interface Design Window – Metrics Tab 

 

Click Add at the bottom of the screen, to go to the Metric Selection window where you 
will select your metrics. (In the absence of a data source, OVPM would have prompted 
you to select a data source.) 
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OVPM lists the metrics classes in this window. In this example, we also have Data 
Source Integration (DSI) metrics collected by the agent (ASMDRFSECB:DSIPERFMON). 

Expand a metric class and select the metrics you want to graph. (You may select metrics 
from more than one area in the tree.) 

Click OK. 

OVPM fills in the metrics information in the Metrics window. 

figure 11 Metrics Window 

 

 

Click Preview to check your progress. Remember that once you have a data source and 
metrics defined, you can preview your graph as often as you want and make any 
adjustments. 
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figure 12 Graph Preview 1 

 

Your graph can be customized in many ways.  

Go back to the Design – Metrics tab and double-click on a metric (or select a metric and 
click the Properties button) and make the changes you wish in the Metrics Properties 
window.  
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figure 13 Metrics Properties Window 

 

You can customize your metric labels, graph title, and graph type and other attributes 
such as Marker, Color and Line Width. To replace the label, simply type over it. Replace 
your other metrics labels in the same way. See the online help for more information on 
particular field options. Click OK when you have completed customizing graph elements. 

If you select Y axis=right, this allows you, in the Chart tab, to specify a label for the right 
side of the graph to identify the right hand Y-Axis.  

Go back to the Design - General tab and create a title for your graph, enter the graph 
type and graph description.  
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Enter My Graph @@[SYSTEM] in the Title field. A system name will be substituted for 
@@[SYSTEM] when you draw the graph. You can also change the graph type to Area for 
example. 

Preview your graph. Clicking on each metric on the right of the graph allows you to hide 
or show the value for that metric. Sometimes you may not see some of the metrics 
because they are hidden behind other metrics with larger values. 

figure 14 Graph Preview 2 
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Go back to the Design window and select the Chart tab.   

figure 15 Java Interface Design Window – Chart Tab 

 

Make any changes that will give the graph the appearance you wish.  

Right Y Axis allows you to specify a label for the right side of the graph to identify the 
right hand Y-Axis. This field will be ignored unless at least one metric has "Right Y-Axis" 
selected in the Metrics tab. 

For Area graphs, set the Effects to stacked so that all the metrics will be visible. 

Click Preview again to see the results.  

In the graph window you can select a different graph type by pressing one of the graph 
type buttons at the top of the window. If you select the bar graph icon the graph changes 
as shown below. 
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figure 16 Graph Preview 3 

 

Go back to the Design window and save the graph by pressing the Save button. In the 
Save As window, the Family, Category, and Name fields control how this graph is located 
among other graphs. Note that you should not use consecutive spaces in the graph name; 
otherwise, OVPM will not find the graph. (OVPM will find this graph name "This is my 
graph", but not "This is     my  graph".)  Also the graph name should not contain "@@" 
symbols. 

 

Click OK. Once you save a graph, it becomes available for you to use as any other 
predefined graph. 
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Return to the Display window. 

Select one or more MWA systems. 

Since this graph has a MWA data source, it will be available in the Graphs pane for any 
MWA system you select. The graphs you see in the Graphs pane depend on the systems 
selected in the Sources pane. 

figure 17 Display Window View Custom Graph 

 

 

“My Custom Graph’ appears in the Graphs pane under the Family Julia and the 
Category Test Graph. Select the graph and press Draw.  

You should see one graph for each system. Note that the system name appears in the 
title. 

figure 18 'My Custom Graph' for Several Systems 
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Using Planner in the Java Interface 

You can use the Planner tab in the OVPM interface to design and execute trending 
models against a single metric.  See the OVPM Planner Guide for more information 
about statistical forecasting and details on how to use the OVPM Planner. 

Note that to access the Planner in the OVPM Java interface, select the Design tab and 
select a graph Type=forecast.   

 

Then you will see the Planner tab active on the right hand side of the Design display. 
Selecting the Planner tab displays the following screen, where you can select the type of 
forecast and other forecast settings. 
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Using Expert Mode in the Java Interface 

If you log in to OVPM as an expert user, then the Expert tab in the Design screen will be 
active. Selecting the Expert tab displays the following dialog box. The System 
Administrator uses the Administrator's Interface to configure users and to set or unset 
the "expert" flag for them. The default logon (blank) will not have the option to work in 
expert mode.   
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System Information 

 

In addition, expert users will see additional client configuration options in the Settings 
dialog box displayed when they select the Settings button at the bottom of the Java 
interface or select the Settings tab in the Web Forms interface. 

 

System Information 

In the Java interface, you can get agent system information by selecting one or more 
systems then pressing the System Information button in order to generate a System 
Information Report. The data for this report is obtained by querying the system to 
discover what data sources are present. If the OVPA (MWA) or OVOA (Coda) data 
sources are discovered, then the system information they provide plus a list of all data 
classes they supply will be included in the report.  
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figure 19 System Information 

       

Java Graph Features 

Java graphs are interactive. As you hover over the graph, OVPM will display the exact 
value for the datapoints while at the same time adjusting the date and time when the 
datapoint value was captured. 
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figure 20 Java Graph Interactive Feature 
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You can display your graph as an area graph, stacked bar graph, bar graph or line graph. 

figure 21 Area Graph 
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figure 22 Stacked Bar Graph 

 

 

 

Drill Down 

With the Drill-Down button, you can select an area on the graph for which you can then 
request more detailed information in the Drill Down Properties window.  

figure 23 Drill Down Selection 
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figure 24 Drill Down Properties 

 

 

You can then select to see the same metrics as in the original graph, but in more detail, 
either as a different graph type (ranging from bar to pie or gauge), or in table format. 

The table format is shown in the following screen shot. This drill down shows Process 
Details.  
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figure 25 Drill Down to Process Details 

 

You can also drill down to see a new graph for the area you selected. In this case, you will 
need to choose a graph from the list of graphs provided. Note that the metrics will then 
be different. 

figure 26 Drill Down to New Graph 

 

 

Export from a Graph 

With the Drill-Down button, you can select an area on the graph for which you can then 
request more detailed information in the Drill Down Properties window.  
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figure 27 Export Selection 

 

 

You can then select the format and destination of the exported data using the Export 
Data dialog 

  

If you leave the File Name blank then the data will be displayed in a new Web Browser 
window. Enter a file name or press the File… button to select a file on your local disk as 
the destination. Press OK to complete the operation. 

Print Graph 

Use the Print button to print the currently displayed graph.  

 

You have a number of options in printing the graph.  For example, you can set up the 
print properties of the page such as the paper size and orientation.  And you can print 
the graph without having to print the browser header information. 
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62 



Using OVPM – Java Interface 

Java Table Features 

Java tables allow you to interact with the table after it has been drawn.  

figure 28 Java Tables 

 

Arranging and Sorting Columns 

The columns can be rearranged by selecting the column header and dragging it to 
another location within the table.  

You can also sort on a column by clicking on the column header. A sort icon will appear 
in the column and the rows in the table will be resorted based on the value in the 

selected column. To sort by multiple columns, select the multi-sort icon  at the top 
of the table. When you finish selecting the sort columns, press the multi-sort button 
again and the table rows will be sorted as you have indicated.  

To return to the original order, select the header of the TIME column. 

You can change the column width by dragging the right vertical edge of the column 
heading. 
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Java Table Features 

Table Highlights 

You can specify rules to set different color highlighting for cells in a table, based on the 

cell's content. Select the Table Highlights icon  at the top of the table and use the 
Table Highlights window to view and edit these highlighting rules. 

Table Filters 

You can specify filtering rules to set which rows will be displayed, based on the cell's 

content. Select the Table Filtering icon  at the top of the table and use the Table 
Filter window to view and edit these filtering rules. 

Export from a Table 

With the Drill-Down button, you can select an area on the graph for which you can then 
request more detailed information in the Drill Down Properties window.  

figure 29 Export Selection 

 

You can then select the format and destination of the exported data using the Export 
Data dialog 

  

If you leave the File Name blank then the data will be displayed in a new Web Browser 
window. Enter a file name or press the File… button to select a file on your local disk as 
the destination. Press OK to complete the operation.
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Using OVPM – Web Forms Interface Using OVPM – Web Forms Interface 

Drawing Predefined Graphs Drawing Predefined Graphs 

The following example demonstrates how to draw a predefined graph from the Web 
Forms interface.  
The following example demonstrates how to draw a predefined graph from the Web 
Forms interface.  

1 Access the OVPM Home page and click on the Web Forms interface. This will take 
you to the Display Graph window (otherwise accessed via the Display tab).   

1 Access the OVPM Home page and click on the Web Forms interface. This will take 
you to the Display Graph window (otherwise accessed via the Display tab).   

 

2 To draw a graph, you will first select a Template File from the drop-down menu. 
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Drawing Predefined Graphs 

The Template File identifies both available graphs and data source, and works in 
conjunction with the Graph Name, Group, and System Names fields. The values in 
these fields correspond to the template file you select. OVPM refreshes the screen 
whenever you make a selection in one of these fields (Graph Name excepted). 

3 Select a graph name. 

4 Optionally, select a group. You do not have to select a Group; but if you decide to do 
so, OVPM will display in System Names only those systems belonging to that group 
which contain the proper data source for the system you selected. If you keep the 
default 'ALL', OVPM displays all systems within all groups which contain the data 
source you selected. 

5 Select a System Name. For certain groups, OVPM allows you to select Each System 
in Group, that is, all the system listed for that group. If you do not see the system 
you want to use listed in the System Names list, you can type it in the Enter System 
Name field. 

6 Verify that the Date Range and Points Every settings are as you wish. The Date 
Range fields allow you to select the range of data you want to graph. To get more 
data points on the graph, use shorter time periods. The Points Every field controls 
how much data is summarized into a single data point. 

7 Click the Draw Graph button. If you checked the Use Java Graphs checkbox the 
graph will be drawn as a Java graph, otherwise the graph will be an HTML graph. 

Note that the graph size defaults to Medium. If you are drawing a graph with multiple 
metrics for several systems, you might want to change the size to Small so you can see 
several graphs side by side. 

Also note that below the resulting HTML graph (or graphs, if you had selected several 
systems), OVPM includes a brief explanation of the different metrics used in the graph. 
And HTML graph provide the capability to Automatically Refresh the graph periodically. 

 

66 



Using OVPM – Web Forms Interface 

Designing Web Forms Graphs 

To create your own graphs, use the Design tab. You can design a custom graph starting 
from an existing graph or create a new graph from scratch.  

To customize an existing graph, click on the Design tab in the Web Forms interface. 
This will take you to the Graph Designer window.  

figure 30 Web Forms Interface – Design Window 
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Designing Web Forms Graphs 

Select a graph template from the Template File field (bottom of the screen) by clicking on 
the down arrow; then select a graph name and click on Open Graph. Note how OVPM 
fills in the Designer window with all the data pertaining to the graph you selected. 

Select a data source from the drop-down list. 

Change the Title of the graph to include the system the graph is being drawn for (add 
@@[SYSTEM] to the title). Change the Graph Type, if desired, using the drop-down list. 
When you selected a data source, OVPM filled in the matching data classes and existing 
metrics in the Metric Selection table. You can add metrics to a graph by clicking on the 
Metric down arrow in a Metric cell where None is displayed.  You can change the Line 
Type and Marker for each metric using their drop-down menus.   

Note that after you save your customized graph, you can reuse it just like you would any 
predefined graph. 

Also note that when you leave the Graph Designer, OVPM clears the screen of all data. 

Creating a New Graph Using the Web Forms Interface 

To design a graph from scratch, you click on the Design tab in the Web Forms interface. 

In the Graph Designer window, select a data source to use as a model for your initial 
graph (the data source asmdrfs2 (MWA) is shown selected). The data source provides a 
list of data classes and metrics and allows you to preview the graph.  

figure 31 Web Forms Interface Design Window –Sources Section 

 

Reporter and Internet Services are data sources that do not require you to select a model 
system when drawing graphs from these databases. Graphs from these sources represent 
data taken from all services or systems in the database. 

In the example above, the system asmdrfs2 has two data sources. MWA is a data 
collector installed on asmdrfs2.  To choose a system not in the drop down list, enter the 
name in the System Name field and click the Update Form button. 

68 



Using OVPM – Web Forms Interface 

RepSys is a special version of the Reporter data source, internal to OVPM, which allows 
single system data to be drawn from the Reporter database. 

Upon selecting a data source, OVPM retrieves classes and metrics available from the 
data source you selected.  

Use the drop down selector to select data Classes and Metrics. As you select a data class, 
the screen changes to include the metrics contained in the class selected.  

figure 32 Web Forms Interface Design Window – Metrics Section 

 

If you need more lines to select additional metrics, indicate how many metrics you want 
to see on the graph in the Metrics on Form field and click Update Form. 

figure 33 Web Forms Interface Design Window – Graph Features Section 

 

Enter My Second Graph for @@[SYSTEM] in the Title field. When you draw the 
graph, OVPM will substitute the system name in the title. 
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Designing Web Forms Graphs 

Click Draw Graph to see your graph at any time. The system name appears in the graph 
title. 

figure 34 Graph Preview 1 

 

You might want to change the names of the metrics. Simply type the new name in the 
Label field for each metric. You might also want to specify the Line Type and Marker for 
each metric.  

 

 

You can modify the Graph Type. If you think your graph will look better as an area 
graph, for example, select Area in the Graph Type field. Area graphs should be Stacked 
so that all the metrics will be visible. Smaller values may be hidden behind larger ones. 
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Using OVPM – Web Forms Interface 

 

Click Draw Graph to see your graph with the changes you made to add labels and 
change the graph type. 

 

figure 35 Graph Preview 2 

 

 

Once satisfied with your graph, you may save it to reuse it with other systems. 

Remember that Web Forms  Graph Designer does not support as many features as the 
Java interface. If you edit and save in Web Forms graphs that you created in the Java 
interface, some features may be lost. 

Scroll down to the bottom of the form to find the Save Graph button. 
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Designing Web Forms Graphs 

   

Enter a User Template File name and a Save Graph Name. Note that you should not use 
consecutive spaces in the graph name; otherwise, OVPM will not find the graph. (OVPM 
will find this graph name "This is my graph", but not "This is     my graph".)  Also graph 
name should not contain "@@" symbols.  

If you leave the User Template File and the Save Graph Name fields empty, OVPM will 
use the values in the Template File and Graph Name fields. 

Click the Save Graph button to save the graph. 

OVPM displays a message above the Graph Designer stating that Graph xx was 
added to the User xx template file.  

Note that OVPM adds User to the name of the template file. This is to differentiate user-
created graphs from predefined graphs. User-created graphs can be modified and deleted 
while predefined graphs cannot. 

Now return to the Display form and locate your new graph. 

Select the template file you created, and then the graph from the Graph Name list.  

72 



Using OVPM – Web Forms Interface 

 

You may select a group or leave the default All. Continue by selecting one or several 
systems (holding down the Control or Shift key) and clicking on each system. 

Determine the date range for which you want to graph data and your Points Every 
settings. By default, you will see an HTML graph when you draw graphs in the Web 
Forms interface. If you wish to see a Java graph, check the Use Java Graphs box. 
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Designing Web Forms Graphs 

 

You can choose to draw HTML graphs in different sizes. Medium is the default. Use 
Small when you have multiple systems. 

Draw your graph.   
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Using OVPM – Web Forms Interface 

 

If you need more assistance, each screen has a link to a Help page covering details on 
how to use that screen. 

Using Planner in the Web Forms Interface 

You can use the Planner tab in the OVPM Web Forms interface to design and execute 
trending models against a single metric.  See the OVPM Planner Guide for more 
information about statistical forecasting and details on how to use the OVPM Planner. 
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Designing Web Forms Graphs 

 

Configuration Settings 

You can use the Configuration tab to set configurable settings that are local to the client 
browser. These settings will be saved in a Cookie on the client system and accessed 
whenever a request is made to OVPM. The client setting items allow you to change the 
appearance of OVPM graphs and tables but does not allow you to make changes that 
affect other users. If you access graphs from a different client system then these settings 
will be for that system and not your original system. The Client settings items apply 
regardless of the OVPM logon (user or customer) being used. 
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Using OVPM – Web Forms Interface 

If you need to make selections that affect more than one client, or are tied to a particular 
logon or customer, then you should see the OVPM Administration Guide for information 
on how to use the OVPM "Style" files. 

 

If you log in to OVPM as an expert user, then you will see additional fields in the 
Settings screen. The System Administrator uses the Administrator's Interface to 
configure users and to set or unset the "expert" flag for them. The default logon (blank) 
will not have the option to work in expert mode. 
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Designing Web Forms Graphs 
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Graph Examples Graph Examples 

Creating Graphs Using Advanced Features Creating Graphs Using Advanced Features 

The following 4 examples only include the steps to demonstrate how to use more 
advanced features. They do not repeat the steps to create graphs. Each example includes 
the Java and Web Forms procedure.  

The following 4 examples only include the steps to demonstrate how to use more 
advanced features. They do not repeat the steps to create graphs. Each example includes 
the Java and Web Forms procedure.  

•  Using a complex filter•  Using a complex filter 

• Top ‘n’ graph: 1 metric across multiple systems 

• Comparison graph 

• Multi-instance graph 

Complex Graphs for Multiple Sources 

• Creating a complex graph 

Note: All italicized text in the examples must be entered as specified. 

Using Advanced Features 

Using a Complex Filter 

Multi-instance data may vary from system to system but you might want just one graph 
template that applies to all systems. For example, file system utilization for any selected 
systems or per CPU utilization for any selected systems.  

This example illustrates how to create an application graph showing all applications 
sorted in alphabetical order, except the one named "My Application." The filter 
APP_NAME=@ separates the values by the application instances rather than summing 
them together. The HTML Sort By Label option sorts the metrics by application name, 
which is included in the label.  
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Using Advanced Features 

Select a single metric to graph all applications together on one graph. If using multiple 
metrics, OVPM will display each application on a separate graph. Use single quotes 
around any metric value which has a space in it. Note: This example uses OpenView 
Performance Agent (MWA data source) metrics, but the same concept can be applied to 
metrics from other data sources.  

Java Interface  

1 In the Java interface, select a MWA system in the Sources tab.  

2 Add the metric APPLICATION:APP_CPU_TOTAL_UTIL from the Metrics tab. To 
do so, select the APPLICATION class in the Metric Selection window and then select 
the metric APP_CPU_TOTAL_UTIL. 

3 Also from the Metric Selection window: Type in the Label field @@APP_NAME to show 
the application name for each metric. 

4 Type in the Filter field APP_NAME=@&&APP_NAME!='My Application' to show all 
applications, except the one named My Application.  

5 On the General tab window, in the Metric Display Order field, select Label 
(alphabetical).  

Web Forms Interface  

1 In the Web Forms interface, select a data source which supports application type 
metrics (MWA).  

2 Select the APPLICATION class and then select the metric APP_CPU_TOTAL_UTIL. 

3 Type in the Label field @@APP_NAME to show the application name for each metric. 

4 Select the "Sort By Label" option. 

5 In the Metric Filter field, select APP_NAME from the drop-down menu, and type 
APP_NAME=@&&APP_NAME!='My Application', this will show all applications, 
except the one named "My Application".  

Top 'n' Graph: 1 Metric across Multiple Systems 

This example shows how to create a Top 5 graph that will display only 5 systems that use 
the most CPU, sorted by the top CPU user. As a result only the top 5 CPU users will be 
shown. The Metrics Per Graph and the Single Graph option limit the number of 
systems displayed on a single graph. Sort By Value sorts by the value of the resulting 
data.  

After creating the graph with one system, use the Display tab to draw the graph, 
selecting a group of systems that you are interested in checking.  

Use a single metric so that all systems will be displayed on the same graph.  

Java Interface  

1 In the Java interface, create a graph using MWA, CODA, or RepSys data source. 

2 On the Metric Selection window, add the metric GLOBAL:GBL_CPU_TOTAL_UTIL 
and type @@[SYSTEM] in the Label field. 

3 On the Chart tab window, type 5 in Metrics Per Graph and select the Single Graph 
option. 
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Graph Examples 

4 On the General tab window, select the Average data value option for the Metric 
Display Order. 

5 Preview and save your graph. 

6 On the Display tab window, select a group of systems, and then select the graph you 
just created. 

Web Forms Interface  

1 In the Web Forms interface, create a graph using MWA, CODA, or RepSys data 
source. 

2 On the Graph Designer: 

a. Select the data class GLOBAL.  

b. Add the metric GBL_CPU_TOTAL_UTIL.  

c. Type @@[SYSTEM] in the Label field.  

d. Type 5 in Metrics Per Graph.  

e. Select the Single Graph option.  

f. Select the Sort by Value option.  

g. Preview and save your graph. 

3 On the Display tab window, select the template file and graph name you created; 
then select more than 5 systems. (Hold down the Ctrl key to select multiple systems.) 

Comparison Graph 

This example shows how to display only 10 systems on each graph when graphing a large 
number of systems. Systems with the highest Memory Utilization values are sorted in 
descending order, with the system name displayed for each value.  

The Metrics Per Graph option used with the Multiple Graphs option causes OVPM to 
create a new graph for the specified number of systems. (Only HTML graphs will work 
this way. Java graphs will show ALL systems on the same graph.) Sort By Value sorts 
by the value of the resulting data.  

Java Interface  

1 Create a graph using any system which has a GLOBAL metric class in your data 
source (for example MWA, CODA, RepSys data source). 

2 Add the metric: GLOBAL:GBL_MEM_UTIL and type @@[SYSTEM] in the Label field. 

3 On the Chart tab window, type 10 in Metrics Per Graph and select the Unlimited 
Metrics option. 

4 On the General tab window, select the Average data value option for the Metric 
Display Order. 

5 After saving this graph, draw it from the Display tab window with a large number of 
systems. Remember to select Display graph in HTML to create separate graphs. 

Web Forms Interface  
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Using Advanced Features 

1 Create a graph using any system which has a GLOBAL metric class in your data 
source (for example MWA, CODA, RepSys data source). 

2 Add the metric: GLOBAL:GBL_MEM_UTIL and type @@[SYSTEM] in the Label field. 

3 Type 10 in Metrics Per Graph, select the Multiple Graphs option and check the Sort 
By Value option. 

4 After saving this graph, draw it from the Display tab window with a large number of 
systems. 

Multi-Instance Graph 

This example shows how to create a multiple-instance graph where the set of metrics for 
each instance is displayed on separate graphs. This is useful with systems that have 
multiple CPUs, disks, network interfaces, or protocols.  

This example will graph individual CPUs; each CPU is identified, and each CPU will 
have its set of metrics displayed on a separate graph (only with HTML graphs).  

• Setting the Filter to BYCPU_ID=@ separates the metrics by individual CPUs rather 
than summarizing them together.  

• Using @@BYCPU_ID to show the CPU name in conjunction with the Sort By Label 
option will group the metrics together for each different CPU. 

Set the Metrics Per Graph value equal to the number of metrics that you choose for the 
graph. In this case, we use 3 metrics. The label must display the CPU instance name at 
the beginning of the label for the sort feature to work correctly.  

Make sure to choose a data source that supplies the metrics you need. Not every agent 
supplies the same metrics on all platforms.  

Java Interface  

1 In the Java interface, create a graph using any system that has the desired metrics 
from the data source selection list. 

2 Add 3 metrics from the same data class (e.g. CPU class)  

• CPU: BYCPU_CPU_TOTAL_UTIL  

• CPU: BYCPU_CPU_SYS_MODE_UTIL  

• CPU: BYCPU_CPU_USER_MODE_UTIL  

3 Set the Filter on all metrics in the Metric Selection window to BYCPU_ID=@. 

4 On the Metrics tab window, select each metric individually, and add the String: CPU 
@@BYCPU_ID at the beginning of each label. This will place the instance name at the 
beginning of the label, which allows you to sort the metrics by instance name. 

• CPU @@BYCPU_ID Total Utilization  

• CPU @@BYCPU_ID System Mode Utilization  

• CPU @@BYCPU_ID User Mode Utilization  

5 On the Chart tab window, type 3 in Metrics Per Graph and select the Unlimited 
Metrics option. 
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Graph Examples 

6 On the General tab window, select the Label (alphabetical) option for the Metric 
Display Order. Remember to select Display graph in HTML to create separate 
graphs. 

Web Forms Interface  

1 In the Web Forms interface, create a graph using any system that has the desired 
metrics from the data source selection list. 

2 Add 3 metrics from the same data class (e.g. CPU class)  

• CPU: BYCPU_CPU_TOTAL_UTIL 

• CPU: BYCPU_CPU_SYS_MODE_UTIL  

• CPU: BYCPU_CPU_USER_MODE_UTIL  

3 Set the Filter to BYCPU_ID=@. 

4 Add the string: CPU @@ BYCPU_ID at the beginning of each label. This will place the 
instance name at the beginning of the label, which allows you to sort the metrics by 
instance name. 

• CPU @@BYCPU_ID Total Utilization  

• CPU @@BYCPU_ID System Mode Utilization  

• CPU @@BYCPU_ID User Mode Utilization  

5 Type 3 in Metrics Per Graph, select the Multiple Graphs option, and the Sort By 
Label option. 

Complex Graphs 

Creating a Complex Graph with Different Data sources 

This example shows how to combine two different data sources, OV Performance Agent 
(MWA) and Internet Services (OVIS), on the same graph. On this graph you will use 
system CPU utilization together with Internet Response time. Note: Complex graphs are 
only supported in the Java Interface. 

1 When creating a complex graph, start by selecting Complex Graph Design Using 
Multiple Sources in the Sources tab window. 

2 Click the Add button to select sources.  

a. In the Add Source window, select a MWA system and data source. Note that 
OVPM automatically labels this source Source 1.   

b. Double-click on Source 1 to access the Edit Source window and change Source 
1 to Web Server. (Or select the Source row and click on Edit.) 

c. Repeat this step to select the OVIS data source using Service Group as the 
Source Name. 
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Complex Graphs 

3 On the Metrics tab window, add a metric to each source and specify the metric label 
for each source. Note that when you access the Metric Selection window, OVPM has a 
source drop-down list that allows you to specify the source for which you are selecting 
metrics. 

a. Add a metric and label for Web Server 

Source: Web Server 

Metric: GLOBAL:GBL_CPU_TOTAL_UTIL 

Label: CPU Util on @@[SYSTEM] 

b. Add a metric and label for Service Group 

Source: Service Group 

Metric: IOPS_PROBE_DATA:RESPONSE_TIME 

Label: Response Time 

4 Preview your graph, and then save it (with the Save As option). 

5 To reuse your graph for other systems/services, in the Display tab window, select the 
graph you created and press Draw. 

6 Because the graph contains multiple sources, OVPM then displays the Select Graph 
Source dialog box for you to select a system or service for each source. After making 
your selection, press OK and OVPM will draw the new graph. 
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Troubleshooting Troubleshooting 

Troubleshooting Data Display Problems Troubleshooting Data Display Problems 

The following gives you some information to use in troubleshooting problems getting data 
to display in OVPM:   
The following gives you some information to use in troubleshooting problems getting data 
to display in OVPM:   

• No names are in the System Name box • No names are in the System Name box  

• Agent not found on a system  

• Unable to find the first web page  

• Unable to find graph  

• OVPM does not respond  

• No graphs display in Java interface  

• Data overlaps in area graphs  

• A graph does not display all of my metrics  

• No data found in the selected range  

• No data is shown in a graph  

• Export gives an access error 

• Cannot print tables 

No names are in the System Name box (Web Forms) or Data Sources 
window (Java Interface) 

• In the Web Forms, the contents of the System Name box will vary based on the types 
of data sources that are in the selected report template. System Names will be 
available when the data source is MWA, or Coda. No system names will be generated 
for the data source Reporter. If more than one data source is in the template file, 
then the System Name field will contain a mixture of names for all those data 
sources.  
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Troubleshooting Data Display Problems 

• In the Java interface, all system names that are configured are displayed. If Reporter 
is configured and customers are present in the Reporter database, then only those 
systems that match the current logon customer will be shown. If an invalid customer 
or password is entered, then no systems will be shown. If you add a valid system but 
then are denied the ability to draw a graph from it, then customer security may be at 
work. 

• No system names can be found. System names are provided from the Reporter 
database if it is present. Otherwise, your system administrator must configure the 
system names for each data source. Contact your system administrator for help.  

Agent not found on a system 

• When drawing a graph, you may get a message similar to MeasureWare Agent not 
found on XYZ (Socket connection was refused). This indicates that OVPM was 
not able to connect to the agent running on that system.  

• Contact your system administrator. They can check to be sure an agent of the 
selected type is actually running on that system (it may not be installed, or it may 
have been stopped). Or determine if you are trying to connect to the wrong type of 
agent? They can also verify that the network connection is up and running.  

Unable to find the first web page 

It is possible that the OVPM web service is not running on the system to which you are 
attempting to connect. Try to access the same URL without the OVPM at the end. 

http://system:8080 

If you see a web page describing Jakarta web server, then the web server itself is 
running. It is still possible that something has happened to the OVPM application. Your 
system administrator can check on its status. 

When OVPM is installed or re-initialized, it creates a web page called index.htm in the 
web server OVPM directory. If you attempt to start OVPM and get an error message, it 
may be caused by the inability to display this web page. Have your system administrator 
check to see that this page is present. 

Unable to find graph 

The Web Forms cannot locate a graph if the Graph Name includes more than 1 
consecutive space. Do not use consecutive spaces in the graph name. (The Web Forms 
will find this graph name "This is my graph," but not "This is     my  graph.") 

OVPM does not respond 

• Sometimes, OVPM will not let you proceed until you take some action in a dialog box 
that seems to have vanished from your screen. Press ALT-TAB to bring up the dialog 
box. ALT-TAB allows you to toggle between windows and will bring up any window 
that may seem to have disappeared but is simply hidden behind other screens.  

• When Analyzer is timing out, OVPM will display a blank grey box. Try to determine 
what is causing the time-out and fix it. Then restart OVPM. 
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Troubleshooting 

No graphs display in Java Interface 

In the Java interface, OVPM displays a list of graphs only after you select a data source. 
Select a system in the left pane. If no systems are present, then you may have to provide 
a valid customer name and password. Locate the Logon button at the bottom left of the 
Java Display screen. If it is there, then this indicates that customers are configured 
(maybe for Internet Services, maybe for Reporter and all systems, maybe for both). Ask 
your system administrator if you need to use a customer logon in order to see systems. 

Data overlaps in area graphs 

Area graphs should either be stacked or the Fill styles should be other than Solid to see 
overlapping data. 

A graph does not display all of my metrics 

In Web Forms interface Design window, the Metrics per Graph option is preset to the 
default value of 8. This value takes precedence over the actual number of metrics defined 
in the graph template. To see all the metrics defined in the graph when you draw it, 
either match the value in Metrics per Graph to the actual number of metrics defined, 
or select the Multiple Graphs option. The Multiple Graphs option will enable HTML 
graphs to display the extra metrics on a separate graph, and will enable Java graphs to 
display all the metrics on the same graph. 

No data found in the selected range 

• A Configuration Details graph shows no data found in the selected range … 
Please use these tips to draw this type of graph for different agents: 

⎯ OVPA (MWA or CODA data source): In Duration, select Points Every = day 
and a large date range to capture the time when a record was logged. MWA logs a 
configuration record only when the agent is started. This will be different for 
each system. 

⎯ OVOA (CODA data source): In Duration, select a very small date range, such as 
1 hour, to capture the data.  

• Sometimes graphs drawn in the browser do not refresh even when the browser is 
configured to not cache pages. To work around this problem, you can force page 
reloads by selecting Ctrl+F5 or Ctrl+R. In extreme cases it is necessary to right-
click on the image, select View Image, then right-click on the image and select 
Reload.  

• Using the Java interface Design tab, previewing graph does not work if the graph 
type is gauge, baseline or xml. Save the graph, and then draw it from the Display 
tab.  

No Data is shown in a graph 

It is possible to draw a graph that shows no data when you expect data to be displayed. 
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Troubleshooting Data Display Problems 

If you get an error message indicating Could not make connection to agent or The 
metrics in graph <graphname> were not found on this data source, then it 
indicates that either OVPM could not contact the system or data source requested, or 
that it contacted it, but the list of classes and metrics do not match those required in the 
graph definition.  

• Click the System Information button to request a report against this system. The 
report will tell you what data sources are available on this system. The agent on the 
system may not provide the metrics you are trying to graph. For example, the 
Operations Agent does not provide Process, Transaction or Application metrics. 

• Make sure you have selected a system that provides the metrics for this graph and 
that that system is operational and accessible. If you are attempting to draw a graph 
provided by a Smart Plug-in, make sure that SPI is properly deployed and collecting 
data. You may have to wait as much as 10-15 minutes before data is available from a 
newly deployed agent or SPI.  

• Check the graph definition and compare it to the data source you selected to insure 
they are compatible.  

⎯ Open the graph in the Graph Design window. Examine the metrics in the Metrics 
tab.  

⎯ Open another Graph Design window. Select the Metrics tab, and then select the 
data source from the list (or you may first select the data source from the Sources 
tab). Examine the list of available metrics for this data source.  

⎯ Compare this set of metrics to those in the original graph definition. 

• If you are presenting a graph versus a table or XML document, then only numeric 
items can be displayed. Non-numeric items are shown in the metric list with quoted 
names. Make sure that at least, one numeric metric is selected for a graph.  

• If you are drawing a graph, but that graph is empty: 

⎯ Verify that the Date Range and Ending are not selecting a time when no data 
exists. Change Date Range to All (in the Web Forms Interface) and re-draw the 
graph. If you get a graph this time, examine it to determine what dates and times 
have data available. 

⎯ If it appears that the date and time range you selected have data now, but not 
when you draw a smaller date range, or if you still get a blank graph: You may 
have the situation where data is present sporadically, or at intervals less than 
your Points Every setting. Change the graph type to Table, and set the Points 
Every to Unsummarized. When you draw this graph, you should see each data 
point from the data source. If this table is blank, then there truly does not appear 
to be any data in the date range you selected; try Date Range All again. 

⎯ When data from the data source is present less frequently than your Points 
Every setting, then you can graph data that appears invisible. Actually it is a 
graph that is trying to draw a line between ONE data point (cannot be done). You 
can:  

⎯ Change your graph settings to select a marker for each data point.  

⎯ Change the Missing setting to Previous or Zero.  

⎯ Change your Points Every setting to be equal or greater than the distance 
between each data point.  

  

88 



Troubleshooting 

Export gives an access denied error 

If you get a popup error window each time you try to export data saying that permissions 
are denying access to this function, then look into these areas: 

• When you started the Java user Interface or first loaded a Java graph. If you 
were asked whether to accept the applet certification and selected "Deny" then 
this is what is denying the ability to export data. In order to export data outside 
of the web browser environment you must accept the applet certification. 
 
Stop all web browsers on your system (even ones not running the OVPM 
application.) This is to force the browser to stop caching the Java applet and load 
a new one. 
 
Start the OVPM Java Interface or draw the Java graph again. This type when 
asked whether to accept the applet certificate, select "Accept" or "Accept Always". 

• The Java applet you are using may not be properly signed. If you have never 
been asked to accept or deny the applet certificate check to see that the 
insightapplet.jar file on your OVPM server is the same one that was shipped with 
OVPM. 

Cannot print tables 

OVPM does not support printing of graphs in table formats. To print the information, use 
the Export function, save the file in one of the formats listed, and open the file in an 
application such as Microsoft Excel to print the table. 
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H 
highlight table cells, 64 
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HTML graph, 28 
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interface 
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Internet Services graphs, 33 
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Java Display window, 36 
Java graph, 28 
java graphs 

interactive features, 55 
Java interface, 17 

create a new custom graph, 41 
customize an existing graph, 41 
draw a predefined graph, 35 
draw a predefined Reporter graph, 38 

Java interface Design window, 40 
Java plug-in requirements, 20 
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Java tables, 63 

L 
limit systems per graph example, 81 
logon and password, 16 

M 
metrics not displayed, 87 
metrics not found in data source, 88 
metrics properties, 47 
metrics section, 69 
metrics selection, 44 
metrics window, 45 
multi-instance example, 82 
multiple datasources graph example, 83 
multiple systems example, 80 

N 
no data found in range, 87 
no data in graph, 87 
not responding, 86 

O 
out of the box graphs, 29 
OVPM 

how it works, 13 
overview, 9 

OVPM home page, 15 
OVPM home page not found, 86 
OVPM overview, 9 
OVPM user interfaces, 17 

P 
performance comparison graphs, 30 
performance manager 

overview, 9 
planner 

overview, 12 
points every description, 28 
pop-up blocker disabled, 19 
predefined graph templates, 24 
print style, 16 
process details, 59 
process graphs, 31 

R 
Reporter graphs, 32 

S 
save graph, 50, 71 
sources section, 68 
stacked, 49 
style description, 16 
system admin add systems, 23 
system information, 54 
system names missing, 85 
systems 

edit list of, 22 

T 
title, 48 
title section, 69 
top n graph example, 80 

U 
unsummarized, 28 
URL for OVPM, 15 
user defined graph templates, 23 

W 
web forms interface, 17 

create a new custom graph, 68 
customize an existing graph, 67 
draw a predefined graph, 65 
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